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INTRODUCTION

NoteBran is a presentation system designed to (1) facilitate the presentation of information by placing a
variety of different mediums and presentation techniques into one central access point, and (2) to archive
this information in a manner that makes it easily accessible and reviewable for students or other
interested parties. This system is implemented on Tablet PC’s connected together via wireless network,
and to a central server containing lecture, webcast, and discussion content.

This prototype of NoteBran includes presentation slides, note taking/drawing capablities, an in-
lecture/reviewable discussion panel, and a reviewable webcast. Our experiment attempts to identify key
usability problems to be addressed in our final iterative design. This pilot usability test involves three
users from one of our representative user groups, who each undergo user testing with three representative
tasks. Throughout the test, group members took detailed notes and observations and logged critical
incidents, whether positive or negative.
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UPDATES

Previous episodes of NoteBran featured two initial user groups: students and instuctors. In this
experiment, we decided to focus on one of our two initial user groups, the students. Many usability issues
overlap between the two user groups because they both (1) use the same, shared graphical interface, (2)
create and import content, and (3) use a pen-based input device. Thus, information collected here should
generally apply to both user groups. In previous assignments, we found that the complexity and workload
associated with two user groups was difficult to manage, given the time constraints. Another
consideration we made when making this decision was the similarity of some of our tasks to existing
authoring tools such as Microsoft Powerpoint. Most computer users are already comfortable with using
Powerpoint to create presentation slides, so we decided that our application would complement
Powerpoint’s functionality instead of replacing it.

Based on heuristic evaluations by our classmates and our own observations of our interactive
prototype, we also redesigned various elements of the interface. We fixed many of the bugs that plagued
our initial interactive prototype. We also removed program modality in response to our reviewer’s
feedback. Our current iteration has a functioning toolbar, disabled buttons when necessary, message
posting capabilities, archived webcasts, and Open and Save capabilities (please see Appendix A for
screenshots).
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METHOD

PARTICIPANTS

Since NoteBran is targeted towards users in a large university setting, we drew our test users from a
pool of UC Berkeley students. Tobey* was selected for his background in computer science. He has
experience with graphics programs and user interface design, so we hoped to bring his insight into our
product. Shiromagura is an immigrant who is quite familiar with computer applications. She is not
from a technical field, she has an international background, and English is not her first language (30% of
people in UCB do not have English as their first language), which will bring a fresh cultural perspective on
our interface design. George is a chemistry major who deals with visually-heavy courses that include
diagrams of molecules and chemical equations. The levels of their computer technical knowledge are
evenly distributed from low (George), medium (Shiromagura), to high (Tobey). In contrast to previous
contextual inquiries and low-fi prototype testing, in which the majority of the participants were female,
we chose 2 male participants and 1 female participant for this experiment. Neither Tobey nor George have
used pen input devices before; Shiromagura is somewhat uncomfortable using tablet PC. We feel this
pattern reflects the current computer usage on campus and shows that an adjustment period might be
required to switch from using regular computers to tablet PC’s.

* Note: Users’ names have been fabricated to preserve their anonymity.

APPARATUS

All three interviews were conducted in 320 Soda to simulate a natural classroom setting. Even though
NoteBran is designed to be used in a large lecture room, it was logistically impractical for us to conduct all
interviews in such an environment. Equipment in 320 Soda was sufficient for replicating this lecture
setting; a projector displayed a lecture webcast to simulate a live professor lecturing. An audio tape
recorder was placed in front of the user to record the interview process for future reference.

Although our target platform is a tablet PC, we did not have a functioning tablet PC for this
experiment; to compensate for this, we used a pen-input tablet and laptop. For close observations, the
observers sat in a semicircle with the user in the middle and a facilitator next to the user. An appropriate
distance was maintained to make sure interviewers didn’t create any distractions to the user.

TASKS

We began by asking the student to watch a webcasted lecture of CS 61A (imagining himself in the
lecture room with the professor and other students). During the lecture, the student was to take notes on
his tablet PC, making use of any available functions that our interface offered (moderate task). We asked
the participant to take notes as he normally might, using notations and other note-taking habits he
already has. Here we were mainly testing the design of the toolbar (how they did or did not use all the
tools available to them) and the design of slide and layer navigation.

While watching the lecture, the participant was to post a new message to the Discussion Panel and to
reply to an existing message (difficult). This tested the design of the Discussion Panel and also provided
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information on the the transition between the interface of the main slide and layers area to the Discussion
Panel. We were interested in seeing if our design allowed for a fluid and intuitive transition.

The final task for the student was to open an archived webcast in an imagined home or dorm room
setting to prepare for an upcoming midterm (easy). This task tested the Lecture Webcast window and its
relation to other elements in the interface. We wanted to see if the participant would be able to easily view
the webcast while viewing the slides and notes.

These three tasks thoroughly covered areas of our interface. Each task focused on a different element
of the design. In addition to allowing us to rigorously test each element on its own, these tasks also
allowed us to determine the ease in moving between elements in the interface.

PROCEDURE

For each of the interviews, three or four members of the group were present. The procedure we
followed for our process was similar to the procedures in our lo-fi prototype testing. We had a greeter to
introduce the user to the general purpose of the program. The user was then told his role in the product
design process and was asked to sign a consent form (please see Appendix B). We then gave the user a
demographic survey to fill out to provide us with information about his background; this step was not
present in our low-fidelity prototype test but was present in this experiment (please see Appendix C). The
role of the “Wizard of OZ” computer simulator was also eliminated from these experiments.

We then began by having the facilitator perform a walk-through demonstration — showing how to
create a basic lecture slide. This was a quick warm-up that gave the user a chance to get comfortable. We
then gave the user time to familiarize himself with the interface. At this point, they explored the toolbar
and windows, and we were able to hear their initial responses to the interface. This also allowed them to
see what functions would be available to them for the tasks they were about to perform.

The facilitator then presented the user with a sheet of paper detailing the first task they were to
perform (please see Appendix F). At this point, if the user had previously agreed to being recorded, we
tape recorded the interview. The user completed the tasks, describing out loud his or her thought process.
Observers took note of the user’s actions as well as any difficulties the user was having with the current
interface. Upon completing the three tasks, we debriefed the participants and opened up the floor for
discussion and suggestions. We asked if any particular part of the interface was confusing or unnecessary
and for suggestions on how they would like to see the interface improved. This procedure was kept
consistent between interviews. Interviews lasted an hour on average.
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TEST MEASURES

Because our system is designed to incorporate many different mediums of information, we wanted to
make sure that our design handled the information in a coherent, intuitive manner. To examine this, we
observed how long it took the participant to get on track towards completing the task. After reading the
task at hand, was the participant staring at the screen for five minutes before taking any action? Or was
the participant able to quickly get started? Here we also listened for oral cues from the participant that
may have shown confusion with the interface (questions or comments they may have had).

Another test measure we looked at was if the participant's behavior followed our expected behavior.
We were looking to see if our design was straightforward or if the participant was continually getting off
track and misled by other elements of the interface. Here we looked for instances where the participant
may have done something in the interface that caused unexpected or no reactions in the interface.
Because we only implemented functions that we felt were necessary to complete the tasks we assigned,
there were areas of the interface that would bring up a window telling the user that a function has not
been implemented yet. By looking at how many times this window appeared, we could also begin to look
at how other elements of the interface might be interpreted and compare it to how we anticipated the user
to behave.
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RESULTS

Dependent variables included in the experiment were time to completion, number of errors, and number
of questions, number of compliments, and number of times a window appeared indicating an
unimplemented function.

Time to Completion

Taski1 Taskz Task3
Note-taking Message Posting Reviewing
Tobey 5mins 1min 45secs 1min 40secs
Shiromagura 5mins 1min 25secs 3min
George 5mins 36 secs 6min

The time to accomplish was not an informative variable for the first task as it was determined by
the length of the webcast clip we were using. However, from our observation, the subjects were able to
make a smooth transition between the different note-taking tools. For the second task the times to
accomplish for all three subjects were similar, however upon questioning the subjects, we found out that
only Tobey understood exactly what he was doing; Shiromagura and George were merely guided by the
prominence of the new message and reply buttons in the discussion interface. When asked exactly where
in the message history their reply was located only Tobey knew exactly where to look. Tobey’s
understanding is likely influenced by his computer experience. Further, all subjects were forced to pause
when asked to uncollapse the subject header to show their actual reply. They initially wanted to double
click the subject header (producing no effect)and only noticed the adjacent arrow after some inspection.

Number of Errors

Taski1 Taskz Task3
Note-taking Message Posting Reviewing
Tobey 1 0 0
Shiromagura 1 1 1
George 1 2 0

Most errors were related to the Discussion Panel and such simple usability quirks like the enter
key not sending a message or focus not automatically shifting to a text area when clicking reply. George
made the more serious error of mistaking static for dynamic text and attempting to modify it. Tobey
added a slide (locally) to the presenter's lecture while he was presenting it. This caused some confusion
largely because of our current implementation, but it also brought attention to the duality of function the
program is mixing together.
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Number of Questions

Taski1 Task2 Task3
Note-taking Message Posting Reviewing
Subject 1 3 2 2
Subject 2 3 3 Y
Subject 3 o) 1 2

Questions were quite varied. Some were implementation relevant while others were conceptual
questions about the intended purpose and functionality of certain features, particularly the Discussion
Panel. George was concerned with it being abused and becoming a distraction amongst students in the
class.

Additionally, we found that no users used layers. After the experiment we asked some of the
subjects to try layers and they found the implementation unclear. This may be a consequence of our
attempts to hide the layer terminology from the users. During the note-taking tasks, the participants took
notes on the Main layer, unaware that they were expected to add a Notes layer. As a result of this, the
testing of our layer interface is relatively limited.
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DISCUSSION

Overall, users found the interface straightforward because of its consistency with applications
with which they were familiar, and all of them performed their tasks smoothly. Some minor usability
issues plague the design, however.

It took some time for users to become accustomed to the Discussion Panel; we attribute this to its
hybrid design of email programs and instant messaging. One user erred by trying to write in the
Message View window. Additionally the Discussion Panel required a change of input; one user had
difficulty juggling the pen and typing on the keyboard, while another tried to draw into the text input
areas. Some users also did not receive enough feedback as to where their newly-created message
appeared in the messages list.

Discussion Panel: Future user interface iterations can include clear labels preceding the
messages list, the selected message, and other widgets. We can increase efficiency for power users through
more shortcuts — including the enterkey for submitting messages — double-clicking to uncollapse
threads, and automatic focus on a text area when replying to a message. Since most users were confused
after posting a message, the interface should automatically highlight the new message to provide
confirmation that the message was successfully sent. We will also eliminate the use of multiple input
devices by placing all focus on the tablet pen and using the included handwriting recognition on the tablet
PC platform to perform text entry.

Toolbar/Slide Navigation: All users encountered difficulty writing notes because of the small
screen estate devoted to the slides, the lack of zoom capabilities, and the lack of a variety of ink stroke
thicknesses. These can be remedied by implementing zoom, and brush size selection. Navigation between
slides should also be updated so that when the user adds a new slide, the interface will automatically scroll
to that slide.

Windows: Window management was spotty, at best. The user interface violated user freedom by
fixing the location of the canvas and the toolbar and lacking keyboard shortcuts for accelerating program
usage. Users also wanted to resize the simultaneous webcast window to zoom in; the next version can
accommodate window resizing.

Lecture Webcast: Webcast control buttons should match conventional systems — time-
scrubbing sliders and a button that toggles between play and pause. When the Lecture Webcast window
appears, it should be located somewhere higher on the screen to level with the user’s line of view.

From these preliminary pilot usability tests, we found that our particpants wrote very few notes.
Admittedly, this was because of several flaws in the experiment. Our users viewed a lecture on an
advanced college-level lecture topic (biology and computer science) that thoroughly confused them, so
they focused more on trying to interpret the lecture rather than on taking or reviewing notes. Future tests
should incorporate easier, more general lecture topics. The "learning effect” could also have impacted
their ability to take notes: all of them had little to no experience with pen-based interfaces, performing
mistakes such as accidental right-clicking and not knowing how to move the cursor. Using a tablet device
separate from the display also prevents them from directly manipulating screen objects, contributing to
this learning effect. In wide-scale usability tests, we would give the user some pen exercises before
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plunging into the real tasks, and, given funding, use actual tablet PC’s. Changing the order of the tasks
would also help alleviate this learning effect.

Future experiments can come with a modified version of the program equipped for usability
testing, allowing us to gauge more dependent variables such as the number of clicks, number of ink
strokes and the number of stray marks the user makes.

Our current user interface has proved to be very usable, but with further refinement of window
management, ink strokes, widgets, and other elements we hope to make digital note-taking as simple as
plain pen-and-paper note-taking, while affording users the flexibility of multiple media possible through a
digital implementation.
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WORKLOAD BREAKDOWN

As a group, we initially met together to discuss some changes we wanted to make to our interactive
prototype based on the heuristic evaluations from our classmates and our own observations over the past
week. Based on each person’s schedule and familiarity with areas of the interface, we divided the rediesign
workload amongst the group. Together we also roughly planned out the interviews and discussed
variables we were looking for.

Steven Chan (25%) was the key person for the Discussion panel. He placed status indicators into the
user interface for the Discussion panel (to give the user status feedback), simplified the message hierarchy
and reworked back-end networking and database code to make the actual prototype fully-functional. He
also helped set up the systems, guided two of the interviewees through the process, and recorded his
observations for the remaining one interview. He is the primary author of the Discussion portion of this
report and edited and proofread content.

Tingting (23%) made the preparation for all the interview materials: consent form, demographic
survey, demo script, task instructions, and task description. She also got her hands dirty on some minor
changes to the login window and menu bar. Tingting is the principle author of the participants, apparatus,
and appendix portions of this report. She participated in all three interviews, taking notes for two
interviews and facilitating for one interview.

Vlad (22%) worked on the toolbar component, the webcast component and (unsucccessfully but
effortfully) worked on downloading a preexisitng webcast and converting into a Flash-usable format. Vlad
was responsible for the results and introduction sections of the report. He also scheduled one user for
testing and was a note-taker for all user tests.

Jennifer (22%) worked primarily on changing the previously existing Library window into the
Open/Save dialog boxes of the program. She ensured that when a file was opened, all elements of the
interface were updated (slides, layers, slide thumbnails). She also created an informative window that
appeared for elements in the menu bar that were not implemented. For the report, she wrote the tasks
and test measure portion and also compiled and proofread all parts of the write up.

Alexey (8%) scheduled a person to do user testing. He then took notes during testing (writing down

their mistakes, things they commented on, etc), digitized the notes and sent it to everyone. He wrote the
procedure of how the testing was done and a paragraph for workload.
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APPENDIX

INTERFACE REDESIGN
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B. INTERVIEW CONSENT FORM

Informed Consent Form

Project title NoteBran Pilot Usability Testing

Course/Study = JK2EODLSF
#

Purpose of the study:

The purpose of the project is to develop a system that makes note-taking more efficient, helps
students communicate with instructors and other students during lecture, and provides students
with easy lecture material archives. NoteBran is an application that combines various media into
one single integrated source, which allows students to use the system for their note-taking,
organizational and reviewing needs.

Your involvement in the study:

The study is expected to take less than an hour. You will first fill out a short survey regarding
demographic information. You will then perform three tasks using NoteBran and will be given
task directions for what you are trying to achieve. You are encouraged to think aloud and give
opinions on any aspects of the project.

Audio recording:

Audiotape recording will be made at your consent. The recording is for the purpose of providing
interviewer supervision, review, quality control and no other purpose. You have the option not to
be audio taped.

Privacy and confidentiality:

All the information collected by the study is completely confidential and is stored anonymously
without personal details.

Participating in and withdrawing from the study:

Participation is voluntary, refusal to take part in the study involves no penalty or loss of benefits
to which you are otherwise entitled, and you may withdraw from the study at any time without
penalty or loss of benefits to which you are otherwise entitled.

1, , give permission to the NoteBran project team to use survey
and notes based on the interview with me on NoteBran Pilot Usability Testing for scholarly and
educational purposes. I understand that these will include a paper to be read by the instructor or
TA in CS160 User Interface Design, Prototyping, and Evaluation, and may include publication
of that paper in an electronic class book that is accessible to students in the class and to other
users of the internet.

(signature of interviewee) (date)

Please sign below if you are willing to have this interview recorded on audio tape.

I am willing to have this interview recorded on tape:

(signature of interviewee) (date)

(signature of interviewer) (date)

All questions regarding this project can be directed to
winning group 6@lists.berkeley.edu
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C. DEMOGRAPHIC INFORMATION SURVEY

Participant ID: JK2EODL8F1

1. What is your age?

e
Under 5 46 - 50

e e
5-10 51-55
E 11-15 E 56 - 60

e e
16 - 20 61 - 65

= L
21-25 66 - 70

e e
26 - 30 71-175

C e
31-35 76 - 80

e e
36 -40 81-85

C L
41 -45 Over 85

Rather not say

2. What is your sex?

Female

Male

Other

Rather not say

3. What is your primary language (i.e., the one you
speak most of the time)?

Korean Chinese
E Japanese Russian
-

E English E French
E German E Spanish
E Danish E Dutch
E Italian E Greek
L L
Portuguese Hebrew

4. What’s your educational level?
Grammar School

High School or equivalent

Vocational/Technical School (2 year)

G 0700

Some College

College Graduate (4 year)

Master's Degree (MS)

Doctoral Degree (PhD)

OooOonon

Professional Degree (MD,JD, etc.)

@

Other

5. What’s your major?
Science

Computer

6. How comfortable do you feel using computers, in
general?

-
Very comfortable
Somewhat comfortable

Neither comfortable nor uncomfortable

Somewhat uncomfortable

OooOon0on

Very uncomfortable

»

before

What’s a computer? Never heard/used it

7. How comfortable do you feel using tablet PCs, in
general?

Very comfortable

Somewhat comfortable

Neither comfortable nor uncomfortable

Somewhat uncomfortable

Ooo0oo0on

Very uncomfortable

-
What’s a tablet PC? Never heard/used it
before

8. What do you normally use to take notes? (Please
check all that apply.)

E »

Pen,
Pencil Notebook
Laptop Highlights
Tape E Eraser
Recorder )
Don’t Others(please specify)
take notes

9. Have you used the following applications before?
(Please check all that apply and specify comfortable
level with following ratings: 1. Very comfortable 2.
Somewhat comfortable 3. Neither comfortable nor
uncomfortable 4. Somewhat uncomfortable 5. Very
uncomfortable)

: £
Microsoft Microsoft Word
PowerPoint 4 1
: e
Webcast BlackBoard
3 -
; E
Course Websites Newsgroup
1 3
: E
Chat (Instant Photoshop
Message) 1
=
iTune RealOne Player
2
L] L]
Quick Time Window Media
Player 1
E
Flash Distance Learning

10. Have you taken cs160 before?

e
&

Yes

No
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Participant ID: JK2EODL8F2

1. What is your age?

=

4. What’s your educational level?

—Business
6. How comfortable do you feel using computers, in
general?

8. What do you normally use to take notes? (Please
check all that apply.)

9. Have you used the following applications before?
(Please check all that apply and specify comfortable
level with following ratings: 1. Very comfortable 2.
Somewhat comfortable 3. Neither comfortable nor
uncomfortable 4. Somewhat uncomfortabl e 5. Very
uncomfortable)

3

10. Have you taken cs160 bgre‘?
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Participant ID: JK2EODLS8F3

1. What is your age?

=

4. What’s your educational level?

=
Chemistry

6. How comfortable do you feel using computers, in
general?

8. What do you normally use to take notes? (Please
check all that apply.)

9. Have you used the following applications before?
(Please check all that apply and specify comfortable
level with following ratings: 1. Very comfortable 2.
Somewhat comfortable 3. Neither comfortable nor
uncomfortable 4. Somewhat uncomfortabl e 5. Very
uncomfortable )

10. Have you taken cs160 bEl_‘;re?
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D. DEMO SCRIPT

Demo: create lecture slides

1. To open the program, double click NoteBran icon on the desktop (application window shows up, 1
blank lecture slide by default)

2. Select pencil from toolbar

3. Write on the first slide: “Lecture 11 ER Diagram”

4. Add another slide by clicking ‘+’ icon (new slide appears in main flame, thumbnail added to
slides thumbnails panel)

5. Write on the second slide: “Overview”

6. To save newly created slides, go to File (dropdown menu)->Save As (prompt window appears)

7. Select “Computer Science” folder in Save in, and type “ER Diagram” in File name, then click Save.

8. Close program by clicking File->Exit.

E. INTERVIEW SCRIPT

Student tasks

You will be watching lecture webcast of ‘CS61A: Abstracting Actions’, while provided with lecture
notes. Suppose this is the course that you are taking to satisfy the social science requirement for your
major. And the lecture materials are tested on the exams. You are going to perform the following three
tasks:

During lecture:

1. take notes(write down things that you find interesting or important. Think about how you
normally take notes, special notations to distinguished the important concepts, different color of
pens, highlights) (hard)

e project web cast onto the screen to fake real time lecture
Expected behavior:

1. Write on the slide directly or click on “Add Notes” icon to add a separate layer
e Annotations (click on icons in the toolbar, highlights, colors...)

2. participate in group discussion by
1) post a new message
2) reply to an existing message
Expected behavior:

1. To post new message, click “New Message...”
2. Type in text field, then click “Send Message”
3. To reply a message, select the existing message, click “Reply Message”
4. Type in text field, then click “Send Message”

Post lecture:

3. The midterm for Biology 1A is coming up. You would like to study for the exam

by reviewing the lecture webcast ‘Tissue Histology’ on 12/12/1904 while
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reorganizing the existing lecture notes. Imagine that you are sitting in front of
your tablet PC at home.

Expected behavior:
1. To open the program, double click NoteBran icon on the desktop
2. To open lecture slides, go to File->Open (prompt window appears)

3.

Search lecture slide and webcast by Look in, File name, or content scroll bar

4. Select ‘Tissue Histology’, click Open(lecture opened in the slide frame, time line shown,
discussion Panel and Webcast Panel shown)

5.

Play Webcast by clicking the play button

6. New notes can be added to existing notes.
7.
8. Close program

To save the updated slides, go to File(dropdown menu)->Save

F. TASK INSTRUCTIONS

You will be watching a lecture webcast of ‘CS61A: Abstracting Actions’. On your tablet PC, you will be
provided with lecture notes that are identical to the one shown in the lecture webcast. Imagine, though, that
you are sitting in a large lecture room with other students and the lecturing professor in the same room. This
is a course that you are taking to satisfy a requirement for your major. Lecture materials are tested on the

exams.

You are going to perform the following two tasks during lecture:

1. Take notes on the tablet PC as you would during any normal lecture. Make use of any available
functions in NoteBran. Think about how you normally take notes—special notations you may use or
any other note-taking habits you may have.

2.

Participate in group discussion by
1) posting a new message
2) replying to an existing message

Now, the midterm for Biology 1A is coming up. You would like to study for the exam by reviewing the lecture
materials. Imagine that you are sitting in front of your tablet PC at home.

3. Reviewing archived lecture webcast ‘Tissue Histology’ on 12/12/1904.
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G. COMBINED CRITICAL INCIDENT LOG

Discussion Panel

» Tobey had difficulty switching between the pen and typing into the discussion panel.

* Shiromagura could not find her composed reply message in the message list. _ When you go back, it’ll
automatically highlight the message you just created.

* Shiromagura tried to draw into the composition box.

* George highlighted the first post and tried to erase static text. _ Tingting thinks that, by default, no
message should be selected and the message detail view should be grayed out.

* George noted that he couldn’t move the windows (even though they actually were moveable).

* Tobey and George tried double-clicking on the folders to expand the list of responses, but it did not
expand. They later noticed the small disclosure triangle on the left.

Webcast

* Tobey wanted video controls. _ Make video controls.

* Tobey liked how all windows were moveable; but, he wanted to also be able to move the canvas
around. _ Tobey, just live with it.

» Tobey was uncomfortable with the webcast showing up in the lower-right corner.

* Tobey wants a combined play/pause button.

 All users wanted the webcast to be resizable. _ Make the webcast resizable. At worst case, just have a
maximize button.

Main Canvas/Toolbar

. Tobey created a new slide but he expected the canvas to automatically scroll to the new slide.

. Tobey tried to write on an invisible layer, but it didn’t show up and he got confused. _ change the
cursor to no symbol.

. Tobey noted that he didn’t know that the layer visibility “eye” icon was even clickable. _ Highlight
on mouse-over.

. Tobey was confused as to why lectures weren’t on their own layers.

. Tobey thought that clicking on “Add Notes” would make a new note pop up. _ Tabs don’t
correspond to layers. OR Just have one layer.

. Shiromagura could not change highlight color. _ Color should go with individual tools.
. Shiromagura did not even understand that the color selector was a color selector.

. Shiromagura expected to draw, but the cursor became a hand instead of an arrow.

o Shiromagura drew an arrow between two slides. _ Cool b/c

. Shiromagura complimented on how smooth the drawing functions went.

. Shiromagura appreciated how all of the tools were visible in one area.

. George could not write things straight. _ Add a grid.

. George wanted to revert his mistake but could not find an Undo function.

. George commented that he would just use the webcast; not look at lecture.

. Shiromagura and George wanted to have bigger slides / zoomable / full-screen.

. All users did not use the menu bar that much.

. None of the users used layers.

. Bug: All users scrolled the main canvas but it also drew ink strokes on the main canvas.
. All users had trouble painting small strokes because the strokes were very large. _ Make strokes
adjustable in width.
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H. RAW INTERVIEWS FOR TOBEY

Task 1:

_"I'm trying to take notes on the lecture but it's up there already."

_ (Error when trying to activate the "Slide tasks)

_ (Error when adding slides?)

_ (Tries to close faulty Biology webcast by going to Window > ... but command does not work.)
_"Finds no incentive to write notes at all."

- Hard to click, Difficult to select colors (too small) -> maybe due to tablet.

- He was just listening, not taking notes

- "+/-" controls of slides - buggy/do not work

- Panels don't disappear

- Zoom feature on slides

- No "undo" button for notes

- Menu does not work a lot (many parts do not display a message that they don’t work)
- No "forward" for slides

* color selection very difficult (due to wacom, but probably on tablet too)

Task2:

_TIME to ACCOMPLISH: 25 sec.

_EXPLORATION: 1 min 20 sec.

_Hit Cancel. "Why did you go back?" I'm looking for an interesting note.

_Focus did not go to edit box when you hit "Create New Message," so he had to manually take his
pointer.

_ "I think I understand this interface now... nothing more to say."

_Dropped pen. "I guess you wouldn't have this problem with a Tablet PC." (Note that he was trying to
type and juggle the pen at the same time.)

_Wanted to put the webcast back on: Tools > Webcast. But command does not work.

- Wants typing

- Difficult to look for interesting messages, reply does not expand well

- Closed discussion panel by mistake, can't open it up

- But, he said "I think I understand it now"

* focus didn’t go to discussion text area when replying

* expected folders to collapse on double click in discussion window

* webcast should above the discussion

* pause/play should be one button

* suggested voting on which questions professor sees

Task3:
_ (Lecture around 6 min)
_TIME to ACCOMPLISH: 1.30 sec. + 10 sec. but had to restart.
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_TIME to ACCOMPLISH:

_Tried to get rid of the slides by hitting "-".

_Moved webcast to the upper-right corner.

_No slider. Where's the slider?

_Tried to pause/play with the same button.

_Tabs: was expecting a whole blank set of notes ...

_The eye helps. :) They didn't look like something that's clickable ... if my mouse went over it and it got
highlighted, then I would consider clicking on it.

_Eraser tool: It erases the notes too, even though it's hidden. I wasn't expected it to erase the layers that
were hidden.

_"I want to have multiple highlights."

_Why is it so hard to change the highlight color?

_The color chooser ... doesn't seem very intuitive ... why would it pop up?

_When I select the eraser, and moves the pen up ... it continues erasing ... it seems to happen more
when I first select something. I don't know why.

_The tool tips stay open.... if mouse leaves too fast, it stays open.

_They're just different sets of what I drew ... and they can go across multiple slides.
...but they can't be deletable, or compact it with a previous layer. I guess that comes from using
Photoshop, though.

_It doesn't matter to me if the notes layers correspond to the slides.

_Iclicked "Add Notes" as much as I could ...

_Color selector doesn't seem to work.

_Interviewee ends up not taking notes at all.

- Trying to find right lecture, but files do not match

- Video panel does not load sometimes

- Double click on open does not work

- Move video on top of discussion panel for easier viewing

- Pause does not unpause (only play does)

- No slider on slides (???)

- click on layers - no change, puzzled

- Layers - does not know how they work, since nothing changes

- Eraser erases everything!!

- No help

- Tool tips stay if pointer moved too fast

- Print preview problem (dialog freezes until selection is made)

- Blue looks gray on layers 4+

- Video - can't rewind/sync to slides

- Full size switch takes time (flash problem)

- Discussion to have voting, anonymous posting, q's only to teacher, etc.

- Scrolling paints next to scrollbar

- Type is better than scribbling with pen -> typing tool

- Video player needs more controls (ff, back, etc)

- "Add notes" does not make sense
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- Control thickness of pencil
- Wants to be able to move everything, esp. main screen + hide/unhide everything.
- Wants keyboard shortcuts.

. blank notes should come up when adding layers

. tabs don’t look clickable (maybe they should highlight on mouse over)

. highlighter color selector doest make sense (should have its own color palette)

. no layer or slide deletion

o layers 4 and 5 colors don't work

. was interested in having links from slides that go to corresponding

portions in webcast

. prefers to type rather than write, wants a text tool

. add notes button doesn't make sense, suggests tool tips -wants to vary thickness of writing tools
USER COMMENTS

And these check, but I feel like I'm missing something.
The Discussion panel seems to be the only thing that works, though ...
I want to be able to click a button and synchronize the webcast.
When you push down ... it doesn't unclick if you lift it up a little. (Tablet issue)
If it actually went to the teacher, that would be neat... there would be a way to ask questions
anonymously or not anonymously, and folks can vote on topics so that there is importance attached to
questions. .... it can just go crazy in lecture.
It needs more features.
Which features did you like?
- I prefer to type rather than scribble ... unless it could convert handwriting, which I kinda doubit. ...
since I'm more comfortable with the keyboard, I'd do more with the keyboard.
The discussion tool I like but it sorta needs to have filters on messages.
I wonder if the Add Notes thing is necessary ... but it doesn't quite make sense ... maybe have tooltips
when you hover over it ... to explain when things are.
Make the video controls more standardized.
I'd also like to control the thickness of the pencil, but it's not that important.
The erase button should function like an eraser, though. :) I'm thinking that the lecture should be
erased.. .and have the tab automatically added... a "Lecture” tab.
but I can't move the whole big screen around ... and the timeline ... 'cuz it's sometimes useless. Hide it
and make lecture notes bigger.
The notes look like they're scanned in ... not high enough resolution. It's a little blurry ... that's not good.
If the notes could be text, then I could edit it.
Just crazy ideas.
I want keyboard shortcuts... forward, slide back ...
(Steve: I think these are coming from his computer usage background.)

OVERALL THOUGHTS
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I think a project of this nature would take a whole lot of time ... to make it useful, it would take a lot of
time.

Tingting: didn't make a PowerPoint comparison.

Did I enjoy it? Yes,... it was entertaining. I wouldn't say it was very useful though.

I prefer typing instead of writing.

Courses: Cs and business.

|. RAW INTERVIEWS FOR SHIROMAGURA

Taski: 1:40--1:45

- Flash cursor stays as a hand (flash bug?)

- Question: can I delete slides?

- Question: can I erase?

- highlighter/pencil too big

- Difficult to take notes (can't find color changer) with the tablet

- Nice: Easy to scroll slides

- Typing is not needed, prefers handwriting

* hand icons not intuitive, it looks like you are about to drag the page down rather than use a writing
tool

* everything is too thick, non variable writing tool sizes...

* unclear that you can change color, tried tools menu, tried holding over highlighter
* completely unclear that you can use color palette on highlighter

¢ scrolling draws along side

* user has had tablet experience but even still finds it very difficult to use wacom
* color selector icon on tool bar didnt register as color selection with user

» want to be able to enlarge lecture window

--key stroke too thick

--how to change color(highlighter and pen have separate color selector)

--draw line between slides

--control of the pen and highlights

--quick, easy to move with slides

--hard to write down everything, with copy of the slide

--(what happened to professor's hand writing?), prefer to write

Task2: 1:51--1:52:43 post a message 1:51-1:52:12, reply:1:52:30--1:52:43

- Must type in the discussion panel (can't write-in, has to switch)

- After posting message-can't see where it is

- Posting idea: make it more advanced, able to select adressants/groups (i.e. have a private chat)

* wanted to use tablet to write inside discussion window

* not sure of purpose, if it is only for professor she would use it

¢ thinks it may be too much stuff to have to deal with sending to particular user, but is also concerned
of value if it send to everyone

* unclear where reply goes after replying
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* didn’t notice reply buttons relations to actual thread in portion

--I thought we can have group discussion, messager, send emails, don't know
the purpose of the feature

--does fold show up if you respond to just 1 message

Task3: 2:00--2:00:13 to open webcast window, --2:03 to finish
Webcast - enlarge

- Volume changer

- Must be able to hide video (sometimes just prof's voice is OK)
- Can't erase!

- Good if could enlarge slides

- But, Basically like the idea of this program

* soundo wouldn’t be bad

* resizable... voice only necessary

* erasing shouldn’t erase underlying lecture slides

--enlarge the webcast window

--idea is interesting, don't really need webcast for reviewing
--you can't write when it's invisible,

--resize the windows, (forget it?)

--virtualization of interface, change color of the toolbar

--not many people are used to tablet, easier to write on screen, slide for full window----

J. RAW INTERVIEWS FOR GEORGE

Taski: 3:00--3:04

* pencil way too fat

* hard to use wacom

* number of ums: 1

* “I know nothing about computer science, what’s null (laughing). The pencil’s so fat”

* Wrote down“((((mike))))”, pretend to know the lecture materials

* “while I am trying to pay attention to this, I have no idea what he is talking about”

* “it’s hard for me to get my hand in the right place, and to write small”

* “Inever used this before, to lift up the pencil and put it back again. It takes practice to get used to
this”

e number of errors: 1, “oops, that’s highlighted”

* number of positive comments:1 “easy to understand how everything works, and everything”
--save file doesn't show the folders

--eraser erases in green, pencil’s fat

--doesn't really use layers, content is confusing,

--grid to write in straight line

Task2: 3:06-3:06:22 for post new 3:06:31--3:45 for reply
* George tried to delete what was in bottom panel of discussion
* found where reply was located after a little bit of looking, might be a distraction from lecture
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e number of errors: 2,

1)highlight message, try to erase when reply to a message(not post)

2)hit enter when send message instead of clicking “send message”

* number of questions (what the question is): 1 “oh, so that’s posted? I don’t really know what’s going
on”(newly posted message isn’t obvious among all others)

e number of positive comments: 2

1)“yeah, that(posting a new message) makes sense, that’s easy”

2) “I guess the discussion panel can be useful, and it’s easy to use”

o “I will write funny stuff in the discussion. Oh, if my name’s gonna show up, hmm, I will probably
behave, then. Haha. If people can post messages anonymously, then they will totally abuse it”

* “Idon’t’ know how it will work in real lecture, I never thought of this before, it’s an interesting idea.
But it might distract me from lecture”

* Steve:“will you use this(discussion panel) in lecture”

“probably, it’s probably helpful in the lecture, if I wanna ask a question or something”

--highlight, then try to delete

--username should show up, distraction from lecture

Task3: 3:12--3:18

* doesn’t think he would study by using the webcast and the slides next to each other

* not sure what adding notes does, because it seem to have no effect

* how many times a "this doesn't work" window pop up:3

* number of questions (what the question is):2

1)“can I open the other window too, it sounds more interesting”

2) “so none of the other lecture exist?” due to “this doesn’t work” window

e number of positive comments: 3

1)“that’s easy, that makes sense, cool”

2)comments on layer “interesting, I guess it could be useful, but not sure how”

3)overall comment “straightforward”

* number of oops: 2 (eraser erases lecture notes)

* Tingting “what do you think of the position of the webcast window”

“it works, but I don’t know if I could make it bigger, movable?”

* “T am used to using a mouse, lift it out, move it off the screen, which is confusing to me. This is
something I can get used to, but... It would be easier to write directly on the screen, that will make more
sense”

e “If I had a webcast, as well as these notes, I will just either watch the webcast, or review the notes. I
am not sure how helpful to have the notes with the webcast”

e “If I had gone to the lecture, I would still want webcast just in case I miss something, or don’t
understand something, I will go back to the specific lecture. I am not sure if I will use this in this format,
notes with webcast in the same screen. I will watch webcast, and take notes using a pencil. At least at
this point, since I am not comfortable using this pen, I will probably get distracted. If I can write on the
screen, I will be less distracted”

* when click “Add Notes” I expected a new slide, or new notes to take notes on, but nothing changes on
the screen, so I am not sure what it supposed to be”
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* “I will be more comfortable get the lecture notes from the website, and take notes with pencil”
--2error message popped up

--didn't see the webcast window, make it big

--convenience, didn't try to move the windows

--undo button, can't move windows

K. TAPE RECORDINGS

The recordings for all three interviews can be provided upon request.
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